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1 Summary
The SAP Strategy Management product installation includes user interfaces in English, French and German.
SP 2 includes also Spain and Portuguese. This document explains how to set up and translate the SAP
Strategy Management user interface to run in a language other than these five languages. Note: Doublebyte languages are not supported in SAP Strategy Management.

2 Introduction
The SAP Strategy Management product installation includes user interfaces in English, French and German.
SP 2 includes also Spain and Portuguese. This document explains how to set up and translate the SAP
Strategy Management user interface to run in a language other than these five languages. Note: Doublebyte languages are not supported in SAP Strategy Management.
When translating SAP Strategy Management terminology into a new language, it is important to keep in mind
that both the layout and the size of elements within the user interface were designed with SAP Strategy
Management Software’s languages in mind. The design may not accommodate words and phrases that are
either much longer or shorter than the original. It is suggested that you stay in range of the original character
length to avoid display problems. For an overview of the available space, run SAP Strategy Management in
either French, German, Spain or Portuguese.
SAP Strategy Management recommends that you make backup copies of all files before modifying them.
Once you have modified the user interface strings files, SAP Strategy Management recommends that you
save copies of the modified files in case you are required to update your SAP Strategy Management
installation.
This document is written with the assumption that you have a working installation of SAP Strategy
Management already in place, and that you are familiar with the user interface. It assumes that a SAP
Strategy Management administrator will complete the tasks in the following order:
1. Configure SAP Strategy Management for the new languages and create the new language strings files
2. Translate the strings files (or send the strings files to professional translators for translation)
3.

Incorporate the translated files into the SAP Strategy Management installation.

Please read through the entire document to become familiar with the steps before starting.

3 File naming conventions
It is important to follow the ISO standard for language codes when naming the SAP Strategy Management
strings files. The file name indicates the name of the language, and is indicated by two-letter abbreviations.
Locale language abbreviations are defined by ISO-639 [1] and are specified in lowercase letters. (See
language ID at the end of this document. Section ‘Related Content’).
For example, the main SAP Strategy Management strings file is called uistrings.en.properties. The
file naming convention for this file in Swedish would be uistrings.sv.properties.
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3.1 SAP Strategy Management Interactive Publisher applets
For the SAP Strategy Management Interactive Publisher applets, you can add the country and variant, as
needed. This takes into account language in places like Quebec, where the language would be french, the
country Canada and the dialect Quebecois. Locale country abbreviations are defined by ISO-3166 [2] and
are specified in uppercase letters. When Java looks for the text file for a given locale when it needs to use
the values it contains, it looks at files starting with the same prefix (ui in our case) in the following order,
stopping when it finds what it needs:
1. name_localeLanguage_localeCountry_localeVariant
2. name_localeLanguage_localeCountry
3. name_localeLanguage
4. name_defaultLanguage_defaultCountry_defaultVariant
5. name_defaultLanguage_defaultCountry
6. name_defaultLanguage
7. name
where:
name refers to the base name; localeLanguage, localeCountry, and localeVariant refer to the language,
country, and variant ISO code; and defaultLanguage, defaultCountry, and defaultVariant refers to the current
default language, country, and variant.

4 Configuring SAP Strategy Management to add other
languages
Before you begin translating the SAP Strategy Management strings files into your local language(s), you
must first set up SAP Strategy Management to run in the additional languages. This section describes the
following:
• Editing the SAP Strategy Management.js file to call other languages.
• Creating the SAP Strategy Management strings files in your language(s).
• Modifying the compile scripts to include each language you are adding.

4.1 Editing SAP Strategy Management.js to call other languages
You must edit the SAP Strategy Management.js file to include the added languages.
4.1.1

To set up the SAP Strategy Management user interface to call additional languages:

1. Open the file SAP Strategy Management.js in a text editor.
2. Search for LanguageList and add the new language to the comma-separated list of SAP Strategy
Management languages you want to display in the SAP Strategy Management user interface:
LanguageList="English,French,German,Spain,Portugueselanguage,language"
Where language is any language that you may have translated on your own. For example:
LanguageList="English,French,German,Spain,Portugues,Swedish"
3. Search for LanguageSuffixList.

4. Add the two-letter ISO code for other languages you want to support in the SAP Strategy Management
user interface:
LanguageSuffixList="eng,fr,de,es,pt,lc,lc"
where eng, fr, de, es and pt are the languages provided by SAP Strategy Management, and lc is the ISO
standard for that language. For example:
LanguageSuffixList="eng,fr,de,es,pt,sv"
Note: The LanguageSuffixList values must directly match the language order you specified in the
LanguageList parameter.
5. Save the file.

4.2 Creating strings files for each language you are adding
SAP Strategy Management recommends copying the English strings files as the starting point for your
translated files. English is the source language for SAP Strategy Management and was the basis from which
the French, German, Spain and Portuguese versions were developed. All the examples in this chapter use
the English files as the source files. However, if your translators are more comfortable translating from
German, French, Spain or Portuguese into your local language, you can choose to copy those language files
instead.
4.2.1

4.2.1 SAP Strategy Management user interface strings file

This file contains the majority of all user interface strings. It contains all SAP Strategy Management strings
except for the Prioritization Matrix and Fishbone strings and the Filters dialog strings. The file also contains
all SAP Strategy Management Administrator strings, including Entry & Approval strings, except for the Entry
& Approval Excel data entry strings, the Strategy Manager, and a few PIP status messages.
There are two formats for this file:
•

uistrings.lg.properties (where lg is the code for the language you are using) located in the \Program
Files\SAP Strategy Management Software\Common\internet\conf directory. This is
the only file you update. Once this file is translated, you run a compile script against the file to
generate the source file used by the SAP Strategy Management code.

•

uistrings.lg (where lg is the code for the language you are using) located in the \Program
Files\SAP Strategy Management Software\Common\internet\SAP Strategy
Management directory. This is the source file that used by the SAP Strategy Management code. It
will be generated the first time you compile uistrings.lg.properties. This file is then updated by the
compile script each time you run the script.

Follow the instructions in this section to create the uistrings.lg.properties file for the language(s) you are
adding.
4.2.2

To create the SAP Strategy Management user interface strings file for each new language:

1. Locate the file uistrings.en.properties in the \Program Files\SAP Strategy Management
Software\Common\internet\conf directory and open it in a text editor.
2. Search for German = German. Below this line, insert the following string for each language you are
adding:
language = language
Where language is exactly as you added it to the LanguageList parameter in SAP Strategy
Management.js. For example:
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Swedish = Swedish
3. Save and close uistrings.en.properties.
4. For each language you are adding, copy the file uistrings.en.properties to a file with the twoletter ISO language code for your language. For example, the Swedish file would be:
uistrings.sv.properties
5. Optional. If your SAP Strategy Management community includes users who will switch between your
language and for e.g. the French and German versions, repeat step 2 to add the language = language
string to uistrings.fr.properties and uistrings.de.properties. This will prevent
"undefined" from appearing in the Language Preferences drop-down list when running SAP Strategy
Management in French, German, Spain or Portuguese.
4.2.3

Prioritization matrix/fishbone strings file

The strings file for the prioritization matrix and fishbone on the SAP Strategy Management Initiatives tab is
ui.lg.properties (where lg is a two-letter code for the language you are using). It is located in the
\Program Files\SAP Strategy Management Software\Common\internet\conf directory.
4.2.4

To create the prioritization matrix/fishbone strings file for each new language:

1. Locate the file ui.en.properties in the \Program Files\SAP Strategy Management
Software\Common\internet\conf directory.
2. For each language you are adding, copy ui.en.properties to a file with the two-letter ISO language
code for your language. For example, the Swedish file would be: ui.sv.properties.
4.2.5

Strategy Manager strings file

The strings file for the Strategy Manger is uistrings.lg (where lg is a two-letter code for the language
you are using). It is located in the \Program Files\SAP Strategy Management
Software\Strategy Plan Manager directory.
To create the strings for the SAP Strategy Management Strategy Manager for each new language:
1. Locate the file uistrings.en in the \Program Files\SAP Strategy Management
Software\Strategy Plan Manager directory.
2. For each language you are adding, copy uistrings.en to a file with the two-letter ISO language code
for your language. For example, the Swedish file would be:
uistrings.sv

4.2.6

Entry & Approval Excel sheets

The strings for the Entry & Approval Excel data entry sheets are contained in the file ExcelMDE.xls, and
the strings for the Entry & Approval Excel historical and target data sheets are contained in the file
ExcelMDEMulti.xls. These files are located in the \Program Files\SAP Strategy Management
Software\Common\internet\metricsmanager directory.
To add additional language strings to the Entry & Approval Excel sheets:
1. Select the file ExcelMDE.xls and click Properties. Uncheck the Read-only box.
2. Open the workbook in Excel. From the Format menu, select the option Sheet, Unhide.
3. In the Unhide dialog, select the Strings sheet and click the OK button.
4. For the first language you are adding, from Column B (the English column), copy rows 2 through 22 and
paste them in Column E. Repeat for any additional languages, adding to rows F, G, and so on.
Important: The code selects the text by position; do not delete or insert any rows or change the position
of anything in the sheet, and do not modify the first column.
5. Rehide the Strings sheet by selecting the menu option Format, Sheet, Hide
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6. Save the changes.
7. From the Tools menu, select Macro, Visual Basic Editor.
8. Select the Module folder and open Module1. At the top of the LoadParse sub-routing, locate the following
code:
'figure out language strings to use before login box or DataEntry sheet are
displayed
lang_abbrev = UCase(Left(wksWorkArea.Range("AppLanguage").Value, 2)) If
lang_abbrev = "FR" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$C$2:$C$30"
ElseIf lang_abbrev = "DE" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$D$2:$D$30"
Else 'default to English
ActiveWorkbook.Names.Add Name:="UIStrings", efersTo:="=Strings!$B$2:$B$30"
End If
9. Ad another ElseIf block to the macro code defining each added column with the two-letter ISO language
code for each language column you are adding. For example, to add Swedish for column E:
ElseIf lang_abbrev = "SV" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$E$2:$E$30"
10. With the file selected, click Properties and redefine the file as Read-only.
11. Select the file ExcelMDEMulti.xls and click Properties. Uncheck the Read-only box.
12. Open the workbook in Excel. From the Format menu, select the option Sheet, Unhide.
13. In the Unhide dialog, select the Strings sheet and click the OK button.
14. For the first language you are adding, from Column B (the English column), copy rows 2 through 29 and
paste them in Column E. Repeat for any additional languages, adding to rows F, G, and so on.
Important: The code selects the text by position; do not delete or insert any rows or change the position of
anything in the sheet, and do not modify the first column.
15. Rehide the Strings sheet by selecting the menu option Format, Sheet, Hide
16. Save the changes.
17. From the Tools menu, select Macro, Visual Basic Editor.
18. Select the Module folder and open Module1. At the top of the LoadParse sub-routing, locate the following
code:
'figure out language strings to use before login box or DataEntry sheet are
displayed
lang_abbrev = UCase(Left(wksWorkArea.Range("AppLanguage").Value, 2)) If
lang_abbrev = "FR" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$C$2:$C$30"
ElseIf lang_abbrev = "DE" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$D$2:$D$30"
Else 'default to English
ActiveWorkbook.Names.Add Name:="UIStrings", efersTo:="=Strings!$B$2:$B$30"
End If
19. Ad another ElseIf block to the macro code defining each added column with the two-letter ISO language
code for each language column you are adding. For example, to add Swedish for column E:
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ElseIf lang_abbrev = "SV" Then
ActiveWorkbook.Names.Add Name:="UIStrings", RefersTo:="=Strings!$E$2:$E$30"
20. With the file selected, click Properties and redefine the file as Read-only.

4.2.7

SAP Strategy Management Interactive Publisher status messages

Status messages displayed by SAP Strategy Management Interactive Publisher are saved as internal strings
in the \Program Files\SAP Strategy Management Software\common\internet\template
directory.
4.2.8

To create the status messages strings for each new language:

1. Locate the file status.htm in the \Program Files\SAP Strategy Management
Software\common\internet\template directory.
2. For each language you are adding, copy the file status.htm to a file with the two-letter ISO language
code for your language. For example, the Swedish file would be:
status.sv
4.2.9

Selector strings

The strings for the Selector (Filters) dialog, which is called from the Scorecard, Dashboard, and Reports
tabs, are contained in the ui.properties file in Jselect.zip in the \Program Files\SAP Strategy
Management Software\Common\internet\classes directory.
To create the Selector applet strings for each language you are adding:
1. Use the command line tool zip.exe to extract the ui.properties from the jselect.zip file.
2. For each language you are adding, copy the file ui.properties to ui_lg.properties where lg is the
the two-letter ISO language code for your language. For example, the Swedish file would be:
ui_sv.properties

4.3 Modifying the compile scripts to include each language you are adding
SAP Strategy Management supplies the compile script pwxmfc.bat, which calls mfc.exe and a second
batch file languageedit.bat, both located in the \Program Files\SAP Strategy Management
Software\Common\internet directory. You run these programs to update the SAP Strategy
Management source files. They contain references to the three language (plus 2 with SP 2) files that ship
with SAP Strategy Management. You must edit these batch files to include the references to the new
language strings files.
Note: pwxmfc.bat calls another batch file that uses jar.exe. Jar is part of the j2sdk. Make sure that you
add c:\j2sdk<version number>\bin to your system path, where <version number> is the version of j2sdk
you are running. For example, c:\j2sdk1.4.2_04\bin.
4.3.1

To modify the pwxmfc.bat and languageedit.bat files:

1. Locate the file pwxmfc.bat in the \Program Files\SAP Strategy Management
Software\Common\internet directory and open it in a text editor.
2. Search for the section that contains the following commands:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\uistrings.en.properties -f both -ojs %SAP STRATEGY
MANAGEMENTJSDIR% -ojava %SAP STRATEGY MANAGEMENTEARDIR%
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%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\uistrings.de.properties -f both -ojs %SAP STRATEGY
MANAGEMENTJSDIR% -ojava %SAP STRATEGY MANAGEMENTEARDIR%
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\uistrings.fr.properties -f both -ojs %SAP STRATEGY
MANAGEMENTJSDIR% -ojava %SAP STRATEGY MANAGEMENTEARDIR%
3. Add new lines, substituting uistrings.lg.properties (where lg is the two-letter language code) for each
SAP Strategy Management strings file you created:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\uistrings.lg.properties -f both -ojs %SAP STRATEGY
MANAGEMENTJSDIR% -ojava %SAP STRATEGY MANAGEMENTEARDIR%
For example, if adding the Swedish file:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\uistrings.sv.properties -f both -ojs %SAP STRATEGY
MANAGEMENTJSDIR% -ojava %SAP STRATEGY MANAGEMENTEARDIR%
4. Search for the section that contains the following commands:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\ui.en.properties -f java -ojava %SAP STRATEGY
MANAGEMENTPROPERTYDIR% call languageedit -pw_language EN -pw_app_directory
SAP Strategy Managementstrategy/cls -pw_file ui -pw_option save -pw_jboss no

%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\ui.fr.properties -f java -ojava %SAP STRATEGY
MANAGEMENTPROPERTYDIR% call languageedit -pw_language FR -pw_app_directory
SAP Strategy Managementstrategy/cls -pw_file ui -pw_option save -pw_jboss no

%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\ui.de.properties -f java -ojava %SAP STRATEGY
MANAGEMENTPROPERTYDIR% call languageedit -pw_language DE -pw_app_directory
SAP Strategy Managementstrategy/cls -pw_file ui -pw_option save -pw_jboss no
5. Add new lines, substituting ui.lg.properties (where lg is the two-letter language code) and –
pw_language LG (where LG is the two-letter language code) for each prioritization matrix/fishbone
language file you created:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\ui.lg.properties -f java -ojava %SAP STRATEGY
MANAGEMENTPROPERTYDIR% call languageedit -pw_language LG -pw_app_directory SAP
Strategy Managementstrategy/cls -pw_file ui -pw_option save -pw_jboss no
Note: Make sure you add the new lines above the command: net start jboss
For example, if adding the Swedish file:
%SAP STRATEGY MANAGEMENTMFCDIR%\mfc -i %SAP STRATEGY
MANAGEMENTCONFDIR%\ui.sv.properties -f java -ojava %SAP STRATEGY
MANAGEMENTPROPERTYDIR% call languageedit -pw_language SV -pw_app_directory
SAP Strategy Managementstrategy/cls -pw_file ui -pw_option save -pw_jboss no
6. Save and close pwxmfc.bat.
7. Locate the file language.bat in the \Program Files\SAP Strategy Management Software\Common\internet
directory and open it in a text editor.
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8. Search for the section that contains the following commands:
if "%1" == "EN" set SAP STRATEGY MANAGEMENTLANGUAGE=en
if "%1" == "en" set SAP STRATEGY MANAGEMENTLANGUAGE=en
if "%1" == "FR" set SAP STRATEGY MANAGEMENTLANGUAGE=fr
if "%1" == "fr" set SAP STRATEGY MANAGEMENTLANGUAGE=fr
if "%1" == "DE" set SAP STRATEGY MANAGEMENTLANGUAGE=de
if "%1" == "de" set SAP STRATEGY MANAGEMENTLANGUAGE=de
9. Add new lines, substituting lg and LG (where lg represents the language code) for each language you
are adding:
if "%1" == "LG" set SAP STRATEGY MANAGEMENTLANGUAGE=lg
if "%1" == "lg" set SAP STRATEGY MANAGEMENTLANGUAGE=lg
For example, if adding the Swedish:
if "%1" == "SV" set SAP STRATEGY MANAGEMENTLANGUAGE=sv
if "%1" == "sv" set SAP STRATEGY MANAGEMENTLANGUAGE=sv
10. Save and close languageedit.bat.

4.4 Running a testcompile of the user interface and prioritization matrix/fishbone
strings files
Test the changes to the compile scripts against your newly created uistrings.lg.properties and ui.lg.properties
files.
4.4.1

To test compile the user interface and prioritization matrix/fishbone strings files:

1. Open the file uistrings.lg.properties in the \Program Files\SAP Strategy Management
Software\Common\internet\conf directory in a text editor.
2. Translate one string in the file. A good one to use for the test is the newly added language string for your
language. For example, if you created the Swedish strings file and added the string Swedish = Swedish,
you would translate it as follows:
Swedish = Svenska
3. Save and close the file.
4. Open the file ui.lg.properties in the \Program Files\SAP Strategy Management
Software\Common\internet\conf directory in a text editor.
5. Translate two strings in the file; one in the [Fishbone] section and one in the [PriorityMatrix] section. Or,
simply, put an X before the term to the right of the equals (=) sign:
ImportanceLow=XLow
6. Save and close the file.
7. Open a Command window and cd to the \Program Files\SAP Strategy Management
Software\Common\internet directory.
8. Issue the following command at the command prompt to compile the files:
pwxmfc.bat

9. When the compile program is complete, go to the \Program Files\SAP Strategy Management
Software\Common\internet\SAP Strategy Management directory and verify that you now have
a file called uistrings.lg, (where lg is a two-letter code for the language you are using) for each of
the new language files you have added.
For example, if you added the file uistrings.sv.properties, you should now see ustrings.sv
in the \SAP Strategy Management directory.
10. Start SAP Strategy Management. (If you get a "Cannot find server" error, it means that JBOSS is still
starting; wait a few minutes and try again). SAP Strategy Management will open in the language you
most recently set in the Preferences. By default this is English.
11. Go to the Preferences/General tab. From the "Set default language" list, you should see the new
language(s) you added to the uistrings.en.properties file. For example, Swedish.
12. Select the new language from the drop-down list, and restart SAP Strategy Management. Go to the
Preferences/General tab, from the "Set default language" list, you should now see your new language,
translated as you did above in step 2. For example, Svenska.
13. Click on the Initiatives tab and select the Prioritization Matrix. You should see the test change you made
to the string in the [PriorityMatrix] section of ui.lg.properties. Next, select the Fishbone Diagram.
You should see the test change you made to string in the [Fishbone] section of ui.lg.properties.

5 Translating the SAP Strategy Management user interface
This section describes how to translate each of the strings files and see the results in SAP Strategy
Management. Each string file is identified in its location in the SAP Strategy Management install.
If you are sending the files out to professional translators, you will need to verify that each file is returned to
its correct location and, when necessary, compiled. You will also need to test the translation in the user
interface to verify that the translated terminology fits within the SAP Strategy Management layout.
SAP Strategy Management recommends establishing a glossary of terms for the main elements of the user
interface before translating the files. This will help ensure consistency throughout the application.
Note: If you have not yet created the new language versions of the strings files, see the section Creating
strings files for each language you are adding earlier in this chapter. If you have not yet updated the compile
scripts, see the section Modifying the compile scripts to include each language you are adding earlier in this
chapter.

5.1 Operating system and regional and language settings
Most user interface elements in SAP Strategy Management are independent of the Windows OS language,
or the regional and language settings. This means that if you set your SAP Strategy Management language
preferences to German, SAP Strategy Management will open in German. However, certain SAP Strategy
Management components are dependent on the Windows system language; for a fully localized version, you
should be running against Windows OS settings for that language.

5.2 Translating the main user interface and prioritization matrix/fishbone strings
files
Both the main user interface strings file and the small file associated with the prioritization matrix and
fishbone require a two-step process to see the new language reflected in SAP Strategy Management. First
you translate the strings files, then, once they are translated, you run a script against the files to compile the
source files used by the SAP Strategy Management code.
5.2.1

SAP Strategy Management user interface strings file

The main user interface strings file is uistrings.lg.properties (where lg is a two-letter code for the
language you are using). It is located in the \Program Files\SAP Strategy Management
Software\Common\internet\conf directory.
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5.2.2

To translate the strings for the SAP Strategy Management user interface:

1. Open the file uistrings.lg.properties in a text editor. The text on the left of the equals sign (=) is
the string identifier, and the text on the right is the term as it is displayed in SAP Strategy Management.
Most of the strings are grouped according to location in the user interface and identified by a comment
string, such as; USERPREF, which indicates the strings for the Preferences dialog. However, some
strings are used in more than one location in the user interface, and these strings are not repeated in the
strings file.
2. Translate the text on the right side of the equals sign (=). For example, if translating into Swedish, it
would look like this:
Cancel = Annullera
Delete = Ta bort
Help = Hjälp
Save = Spara
Update = Uppdatera
Important: Do not execute a global replace of a term. You do not want to change any of the text in the
string identifiers.
3. Save the file. You must compile the file to see the changes reflected in SAP Strategy Management. See
Compiling the user interface and prioritization matrix/fishbone strings files, below.
5.2.3

Prioritization matrix/fishbone strings file

The strings file for the prioritization matrix and fishbone on the SAP Strategy Management Initiatives tab is
ui.lg.properties (where lg is a two-letter code for the language you are using). It is located in the
\Program Files\SAP Strategy Management Software\Common\internet\conf directory.
5.2.4

To translate the strings for the Prioritization Matrix and the Fishbone:

1. Open the file ui.lg.properties in a text editor. The text on the left of the equals sign (=) is the string
identifier, and the text on the right is the term as it is displayed in Prioritization Matrix and Fishbone
views.
2. Translate the text on the right side of the equals sign (=).
For the date format string (DateFormat=MMM dd yyyy), you can change the order, but do not translate
the format. For example, if you want the day before the month, change the string to: DateFormat=dd
MMM yyyy
Important: Do not execute a global replace of a term. You do not want to change any of the text in the
string identifiers.
3. Save the file. You must compile the file to see the changes reflected in SAP Strategy Management. See
Compiling the user interface and prioritization matrix/fishbone strings files, below.

5.3 Compiling the user interface and prioritization matrix/fishbone strings files
To update the SAP Strategy Management strings files with the translated strings, run pwxmfc.bat against the
uistrings.lg.properties and ui.lg.properties files.
To compile the user interface and prioritization matrix/fishbone strings files:
1. Open a Command window and cd to the \Program Files\SAP Strategy Management
Software\Common\internet directory.
2. Issue the following command at the command prompt to compile the files.
pwxmfc.bat
3. Your translations will be reflected the next time you start SAP Strategy Management and select the
language from the Preferences dialog.
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The following sections on the remaining strings files assume that you have already translated and compiled
the main SAP Strategy Management user interface strings file.

5.4 Translating the Strategy Manager strings file
The strings file for the Strategy Manger is uistrings.lg (where lg is a two-letter code for the language you are
using). It is located in the \Program Files\SAP Strategy Management Software\Strategy Plan
Manager directory.
5.4.1

To translate the strings for the SAP Strategy Management Strategy Manager:

1. Open the file uistrings.lg in in a text editor. The text on the left of the vertical bar (|) is the string identifier,
and the text on the right is the term as it is displayed in Strategy Manager.
2. Translate the text on the right side of the vertical bar (|).Important: Do not execute a global replace of a
term. You do not want to change any of the text in the string identifiers.
3. Save the file. Your translations will be reflected the next time you start the Strategy Plan Manager after
setting the language from the SAP Strategy Management Administrator Preferences dialog.

5.5 Translating the Entry & Approval Excel sheets
The strings for the Entry & Approval Excel data entry sheets are contained in the file ExcelMDE.xls, and the
strings for the Entry & Approval Excel historical and target data sheets are contained in the file
ExcelMDEMulti.xls. These files are located in the \Program Files\SAP Strategy Management
Software\Common\internet\metricsmanager directory.
See the section To add additional language strings to the Entry & Approval Excel sheets earlier in this
chapter, if you have not already added the new strings.
5.5.1

To modify the strings for the Entry & Approval Excel data entry sheets:

1. Select the file ExcelMDE.xls and click Properties. Uncheck the Read-only box.
2. Open the workbook in Excel. From the Format menu, select the option Sheet, Unhide.
3. In the Unhide dialog, select the Strings sheet and click the OK button.
4. Find the column for the language you are translating and enter your changes in the existing cells in that
column.
Important: The code selects the text by position; do not delete or insert any rows or change the position
of anything in the sheet, and do not modify the first column.
5. Rehide the Strings sheet by selecting the menu option Format, Sheet, Hide.
6. Save the changes and close Excel.
7. With the file selected, click Properties and redefine the file as Read-only.
8. Select the file ExcelMDEMulti.xls and click Properties. Uncheck the Read-only box.
9. Open the workbook in Excel. From the Format menu, select the option Sheet, Unhide.
10. In the Unhide dialog, select the Strings sheet and click the OK button.
11. Find the column for the language you are translating and enter your changes in the existing cells in that
column.
Important: The code selects the text by position; do not delete or insert any rows or change the position
of anything in the sheet, and do not modify the first column.
12. Rehide the Strings sheet by selecting the menu option Format, Sheet, Hide
13. Save the changes and close Excel.
14. With the file selected, click Properties and redefine the file as Read-only.
15. Your translations will be reflected the next time you start Entry & Approval, after setting the language
from the SAP Strategy Management or SAP Strategy Management Administrator Preferences dialog.
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5.6 Translating SAP Strategy Management Interactive Publisher status messages
The strings file for the status messages is status.lg (where lg is a two-letter code for the language you are
using). \Program Files\SAP Strategy Management Software\common\internet\template
directory.
5.6.1

To translate the status message strings:

1. Open the file status.lg (where lg is a two-letter code for the language you are using) in a text editor.
2. Find the StatusMessage section. Translate the status messages enclosed in quotes to the right of the
equals (=) sign. For example, you would translated the following information identified in red:
StatusMessage["unauthorized"] = "Unauthorized User for this SAP Strategy
Management
Interactive Publisher context or undefined SAP Strategy Management
Interactive Publisher context.@(type=newline name=count value=2)Please
verify User and Context using SAP Strategy Management Interactive Publisher
Administrator."
3. Find the document.write section and translate each phrase that is followed by a semi-colon (:). For
example, you would edit the following information identified in a red font:
document.write("<BR>&nbsp;&nbsp;&nbsp;
<FONT class=reportsectionbold>Status:</FONT>
&nbsp;<FONT class=reportsection>" + PipStatus + "</FONT>")
4. Save the file. Your translations will be reflected the next time you start SAP Strategy Management and
select the language from the Preferences dialog.

5.7 Translating the Selector strings
The strings for the Selector (Filters) dialog, which is called from the Scorecard, Dashboard, and Reports
tabs, are contained in the ui_lg.properties file in Jselect.zip in the \Program Files\SAP Strategy
Management Software\Common\internet\classes directory.
Because you created the new language file by copying the English file, the new file does not yet exist in the
zip file. Once the text file is translated, you will add it to the zip file. Once it is added, you will need to extract
it any time you want to modify the file.
5.7.1

To translate the Selector applet strings:

1. Open the ui_lg.properties file in a text editor. The text on the left of the equals sign (=) is the string
identifier, and the text on the right is the term as it is displayed in the Filters dialog.
2. Translate the text on the right-hand side of the equals sign (=).
3. Issue the following command at the command prompt to add the ui_lg.properties file to the jselect.zip file:
zip jselect.zip ui_lg.properties
4. Your translations will be reflected the next time you start SAP Strategy Management and select the
language from the Preferences dialog.

5.8 Setting non-US delimiters for Trend and Forecast
5.8.1

To set non-US English delimiters for Trend and Forecast:

1. Open the file FORANALYZE1 in a text editor.
2. Scroll to the bottom of the file and change the following code as appropriate:

15

... US – DEFAULT
set def comma ,
... INTL ...set def comma .
3. Perform the same steps for the file FORANALYZE2.

6 Further Information
SAP Language ID in Accordance with ISO 639
AF (Afrikaans)
DA (Danish)
DE (German)
EN (English)
ES (Spanish)
FI (Finnish)
FR (French)
IN (Indonesian)
IT (Italian)
MS (Malaysian)
NL (Dutch)
NO (Norwegian)
PT (Portuguese)
SV (Swedish)
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